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Duke Energy Smart $aver Lighting Instructions

1. GETTING STARTED

The current version of the Custom-To-Go Lighting Savings Calculator can be downloaded from
http://duke-energy.com/CustomToGo. It is included in the Smart $aver Custom-To-Go tool suite,
which contains a number of useful tools that can help you calculate savings and incentives for
various energy saving measures.

The ZIP output file from the calculator must be submitted with the Smart $aver application (Step
1) in order to receive an incentive payment. For application submissions and questions about the
application process, contact us at CustomIncentives@duke-energy.com.

2. MEASURE TooL DESCRIPTION

The Lighting Savings Calculator is a tool used to estimate savings due to the proposed
installation of high-efficiency lighting equipment. The calculator compares the baseline and
proposed fixtures along with overall building characteristics to determine the annual demand
(kW) and energy (kWh) savings.

2.1.Appropriate Use of the Tool

The Lighting Savings Calculator can be used for facilities with the characteristics shown in Table
1.

Table 1: Lighting Savings Calculator Common Features

Description Measure Feature

States Ohio

Indiana
Kentucky
North Carolina
South Carolina

Building Types and e OFFICE
Operating Hours 1. M-F 7a-5p, Sat 8a-noon
2. M-F 8am - 5pm
3. M-Sat 8am - 5pm
e SCHOOL (K-12)
1. M-F 8a-5p (Tradional School Year)
2. M-F 8a-5p (Year Around)
3. M-F 7a-4p (Tradional School Year)
4. M-F 7a-4p (Year Around)
e COLLEGE/UNIVERSITY
1. M-F 7a-7p, Sat 9a-3p
2. M-F7am-7pm
3. M-Sat 8am - 5pm
e RETAIL/SERVICE
1. M-Sat 7a-7p, Sun 8a-5p
2. M-Sat 8am - 5pm
3. M-Sun 8am - 5pm
4. M-Sun 24 hrs
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e RESTAURANT
1. M-F 6a-10p, Sat 7a-7p, Sun 8a-5:30p
2. M-F 6am - 8pm, Sat-Sun 8am - 6pm
3. M-Sun 24 hrs
e HOTEL/MOTEL (GUEST ROOMS)
1. M-Sun 24 hrs
e HOTEL/MOTEL (OTHER)
1. M-Sun 8am - 5pm
2. M-F 8am - 5pm
e MEDICAL
1. M-F 4a-mid, Sat 7a-7:30p, Sun 7a-7p
2. M-F 8am - 5pm
3. M-F7am-7pm
4. M-Sun 24 hrs
e GROCERY
1. M-Sun 6a-10p
2. M-Sun 24 hrs
3. M-Sat 8am - 5pm
e WAREHOUSE
1. M-F6a-10p
2. M-F 8am - 5pm
3. M-F 24 hrs
e LIGHT INDUSTRY
1. M-F 6a-10:30p
2. M-F 8am - 5pm
3. M-F 24 hrs
e HEAVY INDUSTRY
1. M-F 6a-10:30p
2. M-F 8am - 5pm
3. M-F 24 hrs
4. M-Sun 24 hrs
e PARKING GARAGE
1. M-Sun 8p-6a (Summer), M-Sun 5p-7a (Winter)
2. M-Sun 24 hrs
e EXTERIOR
1. M-Sun 8p-6a (Summer), M-Sun 5p-7a (Winter)

2.2.Applicable Types of Lighting Covered by the Tool

The Lighting Savings Calculator includes pre-defined fixture information for the types of fixtures
described in Table 2. In addition, users can define custom fixtures for anything that is not pre-
defined.

Table 2: Equipment Coverage Matrix

Lamp Family Lamp Types
Compact Fluorescent (CFL) e Screw-in
e 4-pin/Biax
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Halogen

Halogen, 45W-300W

High-Intensity Discharge (HID)

Metal Halide (MH)

Pulse-start Metal Halide (PSMH)
CMH

High-Pressure Sodium (HPS)
Quartz

Incandescent

Incandescent, 15W-200W

Induction

Induction, 55W-165W

LED Fixture

1x4 LED

2x2 LED

2x4 LED
Track
Downlight
Canopy
Flood

Wall Mounted
Pole Mounted
Bollards
Other

LED Lamp

A
MR
PAR
BR

R
Other

Linear Fluorescent (LFL)

T5and T5 HO
T8and HP T8
T12 and T12 HO
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3. MEASURE TooL USE

3.1.Select Your Service Territory

In order to properly load the correct utility program the user must first select the service territory
associated with their account. To begin, select your state from the list presented in the Select
State dialog box.

Select Your State

Knowing where your account is located will help us serve you better.

i
NORTH
INDIANA KENTUCKY CAROLINA

v

SOUTH
CAROLINA

If the State of Indiana, Kentucky, or Ohio is selected the application will open the appropriate
service territory version of the software.

If one of the Carolinas is selected the application needs a little more information. In these cases,
a Select Service Territory dialog box will appear. Please either enter the service address zip code
or select the Utility associated with the service account.

To return to the state selection dialog box click on the “Choose State” link.
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Choose State » More Info Meeded

We're going to need a little more information to customize your experience.

Enter Service Address Zip Code

-0OR-

Select a Service Territory by clicking on the utility name on the
left

Greensboro

Asheville

@ Duke Energy
© Duke Energy Progress

Greanville

3.2.Tool Inputs

Tool inputs are done either by selecting predefined dropdown options or entering text or numerical
values as prompted by the tool. To begin using the tool, select File->New Project from the menu
and select the Lighting tool option.
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=£‘- Smart $aver Custom Incentive Program o

File | Help

Mew Project [ Lighting
Open e @~ DUKE

' ENERGY.

Smart $aver Custom Incentive Program

Exit

Custom-to-Go

Thank you for downloading the Custom-to-Go Calculator. This tool is intended to expedite the custom
application review process and provide an estimate of incentives for your custom project(s).

Each project should take just a few minutes to enter, and when complete the tool will provide
standardized output to you and to our review team, including estimated incentive per unit, annual
savings, and several other key metrics that must be considered for incentive estimation.

To get started, click en File > New Project and select the tool you would like to use. We have also
provided a Help document located under the Help menu item.

If you need assistance in using the tool, please leave a message on the Custom-to-Go tool support line at
(866) 380-9580. We will return your call within two business days.

MNew
Lighting Praoject

Open
Existing Project

Verzion 1.0.11

The input window uses a tabbed display. The first tab pertains to facility information, such as
customer name and address, building type, and whether or not this is a new construction project.
The second tab is used to enter the measure details. Multiple measures can be defined, each
representing a unique combination of baseline and proposed fixtures. Existing measures can be
edited by double-clicking on the row to be edited. The third tab displays a brief summary of the
project results and allows the user to generate a detailed savings report. Refer to tables below for
input details.

Version 1.0.0 — 1/28/2016 Page 7 of 16



Duke Energy Smart $aver Lighting Instructions

i ™
:g‘t Smart $aver Custom Incentive Program [ = | =] ﬂ

File Help

Lighting Toola *

Site | Measures | Results

Project Name
Duke Electric Account Number

Customer Name

Options

Cemonstration Measure
123-4567-43294

loe Customer

Project Site Address 123 4th [t
City Terre Haute State Zip 47807
Building Type [D’I"ﬁce "’]
Operating Schedule [M-F 7Tam-5pm, 5at 8am-12pm "’]
Building Area (sq. ft.) 10,000
Average Billing Rate (3/kWh) | $0.085 [C] Override

[C] Federal Owned [C] New Construction

Version 1.0.11

Table 3 - Site/Facility Inputs

Input Name

Description / Purpose

Project Name

Enter a descriptive name for the lighting project.

Duke Electric Account
Number

Enter the customer’s Duke Energy electric account number.

Customer Name

Enter the name of company or facility.

Project Site Address

Enter the address of the facility.

State

Select state from pull down.

Building Type

Select building type from pull down.

Operating Schedule

Select operating schedule from pull down. Note that the options
vary depending on building type.
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Building Area (sq. ft.) Enter square footage of the facility. Do not enter decimals (whole
numbers only).

Average Billing Rate ($/kwWh) | This displays the default billing rate based on location and
building type. If you know the actual average billing rate for the
customer, check the Override box and enter a new value.

Federal Owned Check this box if the facility is owned by a federal agency.

New Construction Check this box if this is a new construction project.
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r )
'{“t Smart $aver Custom Incentive Program E@g
File Help
Lighting Toola % |
Site | Measures | Results
Anticipated Installation Date |[12/29/2015] 3 |
Baseline  Baseline Baseline Proposed Proposed Proposed
# Fixtures Fixture Configuration Watts/Fixture # Fixtures Fixture Configuration Watts/Fixture
100 MH250 295 100 PSMHZ200 232
<< Back l [ Mext > =
Version 1.0.11
L - |
Table 4 — Measure Inputs
Input Name Description / Purpose

Anticipated Installation Date

Enter the anticipated installation date for the new lighting
equipment.

Add Measure

Click this button to add a new row to the table of measures.

Edit Measure

Click this button to edit the selected row from the table above.
You can also edit by double-clicking on a row in the table.

Remove Measure

Click this button to remove the selected row from the table.
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fﬁ Measure Details l = | (=] |ﬁ]
Baseline/Existing Equipment Proposed Equipment
Extericr [ Manufacturer  GE

Meodel  PSMH200-10Q

Application [High Bay - Total Cost of All Fixtures  $5,300
Mumber of Fixtures 100 Number of Fixtures 100
Lamp Family  HID - Lamp Family  HID A
Larnp Type  MH * Larnp Type  PSMH -
Larnps per Fixture 1 - Lamps per Fixture 1 -
Ballast Factor Range | N/A Ballast Factor Range | N/A
Watts per Lamp (Nominal) 250 *  Watts per Lamp (Mominal) 200 A
Input Watts per Fixture | 295 Input Watts per Fixture | 232
Mean Lumens per Fixture | 13,325 Mean Lumens per Fixture | 14 230
Save ] [ Cancel |

Table 5 — Measure Detail Inputs

Input Name Description / Purpose
Exterior Check this box if the fixtures are located in an exterior location.
Space Type Select the type of space where the fixtures are being installed.

This input only applies to New Construction projects.

Total Baseline Cost Enter the cost to install standard efficiency lighting as required by
state and local building codes. Enter the full cost for a complete
installation of all fixtures on this measure, including material, tax,
and external labor. This input only applies to New Construction
projects.

Area Served (sq. ft.) Enter the square footage being served by the fixtures. Do not enter
decimals (whole numbers only). This input only applies to New
Construction projects.

Application Select the application for the fixture. If none of the available
options is applicable, please select 'Other".

Manufacturer Enter the manufacturer of the proposed fixture.

Model Enter the model number of the proposed fixture.
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Total Cost of All Fixtures Enter the full measure cost for a complete installation of all
fixtures on this measure, including material, tax, and external
labor.

Number of Fixtures Enter the number of baseline and proposed fixtures.

Lamp Family Select the lamp family (HID, CFL, etc.) for the baseline and

proposed fixtures. If none of the available options is applicable,
you can type in a custom value.

Lamp Type Select the lamp type for the baseline and proposed fixtures. The
options will depend on the selected lamp family. If none of the
available options is applicable, you can type in a custom value.

Lamps per Fixture Select the number of lamps per fixture for the baseline and
proposed fixtures. If none of the available options is applicable,
you can type in a custom value.

Ballast Factor Range Select the ballast factor for the baseline and proposed fixtures.
This input is only applicable to linear fluorescent fixtures. The
available options are:

e Low(<0.85)
¢ Normal (>=0.85, <=0.95)
e High (>=0.96)

Power Source Select whether or not the proposed LED lamp will be powered by
an existing fluorescent ballast. If the ballast will be removed,
select “Line Voltage”. This input is only applicable to LED tube
replacements.

Watts per Lamp (Nominal) Select the watts per lamp for the baseline and proposed fixtures.
The options will depend on the selected lamp family. If none of
the available options is applicable, you can type in a custom
value. This input does not apply to LED Fixture measures.

Input Watts per Fixture If a standard fixture has been configured using the drop-down
selections, the predefined input watts will be displayed. If custom
values have been used for one or more inputs, you will need to
enter the input watts per fixture. This input does not apply to LED
Lamp measures.

Mean Lumens per Fixture If a standard fixture has been configured using the drop-down
selections, the predefined mean lumens will be displayed. If
custom values have been used for one or more inputs, you will
need to enter the mean lumens per fixture. For LED Lamp
measures, enter the mean lumens per lamp.

Once all information is entered, press the “Save” button on the Measure Details window to save
your measure. Once all measures have been added, press the “Next” button on the bottom right
corner of the Measures tab. The tool will then calculate savings based on the information entered
and display a brief summary of the results. To view a full report, press the “PDF Report” button.
This will generate a PDF report suitable for viewing on screen or printing along with a ZIP file
containing additional detail that Duke Energy will require to process your incentive application.
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3.3.Tool Outputs — Savings Summary
The following table describes the tool outputs.

r ™
o Smart Saver Custom Incentive Program E@ﬂ

File Help

Lighting Toola *
Site | Measures | Results

Smart $aver Custom Incentive Program
Custom-to-Go
Project Summary
Total Estimated Incentives $2.095
Estimated Annual Electric Bill Reduction £1.504
Demand (kW) Energy Usage (kWh)
Site Baseline 29.50 82836
Code Baseline
Proposed 23.20 65,146
Savings — Site Baseline 6.30 17,680
Savings — Code Baseline
Estimated Incentive $945 $1,150
Next Steps

The data entry portion is now complete and estimates of annual savings and incentives are provided on the screen above. The next
steps in securing a final incentive offer, prior to executing your project, are as follows:

1. When you click the “PDF Report” button below a detailed PDF report will be created for your records along with a ZIP file for
use by Duke Energy personnel. Please e-mail a copy of both files to CustomIncentives@duke-energy.com with your
application. Before closing this project, we recommend saving your data to a .CTG file, using the File menu, for future use.

2, If chanaes are desired at this time. vou mav edit. add or delete measures bv clickina the “Back” button and makina the

-

[ =« Back l [PDF Repcrrt...l

Version 1.0.11
Table 6- Measure Energy Savings and Incentive
Name Description / Purpose
Site Baseline, kW Estimated monthly maximum peak demand of the existing
lighting equipment (retrofit projects only)
Code Baseline, kW Estimated monthly maximum peak demand of code compliant
lighting equipment (new construction projects only)
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Proposed, kW Estimated monthly maximum peak demand of the proposed
lighting equipment

Customer Baseline, kWh Estimated annual energy use of the existing lighting equipment
(retrofit projects only)

Code Baseline, kwWh Estimated annual energy use of code compliant lighting
equipment (new construction projects only)

Proposed, kWh Estimated annual energy use of the proposed lighting
equipment

Savings — Site Baseline Estimated peak demand and annual energy use savings, relative

to the Site Baseline values, for the selected measures (retrofit
projects only)

Savings — Code Baseline Estimated peak demand and annual energy use savings, relative
to the Code Baseline values, for the selected measures (new
construction projects only)

Estimated Incentive Estimated incentive from peak demand and annual energy use
savings that can be obtained for installation of the proposed
lighting equipment

Total Estimated Incentives Estimated incentive for the full project
Estimated Annual Electric Bill Estimated reduction in the customer’s annual electric bill due to
Reduction the annual energy use savings.
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3.4.Tool Outputs — Notes and Error Messages
While using the Lighting Savings Calculator, you may see one of the following error messages:

Invalid Input I&

% Please fix the following errors:
* Baseline: You must specify an Application.
* Proposed: Number of fixtures must be greater than 0.

OK

This indicates that you have not made a selection or entered an appropriate value in one or more
required fields. Please review your inputs and make sure that you have entered appropriate
values in the indicated input fields.

Invalid Input @

% Please fix the following errors:
* Proposed Lamp Type 'MH' is not eligible as the proposed fixture,

oK

This indicates that the proposed fixture is not eligible for incentives and may only be used as a
baseline fixture.

Invalid Input @

% Please fix the following errors:

* Proposed Lamp Type Induction’ is not eligible in the Custom-to-Go
program. You may omit this measure, or apply for this measure
through the Classic Custom prograrm.

oK

This indicates that the proposed fixture is only eligible for incentives through the Classic Custom
program. Please submit an application to the Classic Custom program for this measure.
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Invalid Input @

% Please fix the following errors:
* The selected measure is not eligible for custom incentives, Please
apply for this measure through the prescriptive incentives program.

oK

This indicates that the proposed retrofit qualifies for incentives through the prescriptive
incentives program. Measures that qualify through the prescriptive program cannot apply for
incentives through the custom incentives program (classic custom or custom-to-go).

Invalid Input ﬁ

I.-”' '\-.I The calculated incentive amount is negative. Please re-check your
S’ measure inputs,

oK

This indicates that your lighting project will result in negative savings and incentives. Please
review your measure inputs and ensure that all inputs are correct. You will not be able to
generate a report for a project that has negative savings.

r—Imrall'u:l Input @1

I.-"'_"“-. The Custorn-to-Go program does not allow projects with savings

'-\_____,-'I greater than 700,000 kWh/year. Please re-check your measure inputs or
apply for this project through the Classic Custormn program.

] 4

This indicates that the proposed project exceeds the upper limit of the Custom-to-Go program
and is only eligible for incentives through the Classic Custom program. Please submit an
application to the Classic Custom program for this project.
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